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Default English
Menu in English

Profile

Home

C Profile Busi

# P L N 5 Profile ~ RelasiInvestor ~ Sustainability ~ Media ~ | & Kontak @ ENG ~
Indonesia Power

Profile » Profil Kami

Tata Kelola » Manajemen

Manajemen Human Capital » Unit Pembangkit

Anak Perusahaan

KOI'ISiSten Dl.lkung Penghargaan & Sertifikasi
Bauran Energi

Jejak Langkah

Berpengalaman dan Terpercaya selama lebih dari 2 "1. Keterbuksan informasi Publik
tahun bersama membangun negeri

SOLUSI KOMPREHENSIF KAMI

Our Profile
Management
Powerplants




Company Profile Business Solution

PL N_ Profile ~ Relasi Investor ~ Sustainability ~ Media ~ ‘ S Kontak @ ENG ~
Indonesia Power

Annual Report
Sustainability Reports
Statistic Reports

Financial Report

Informasi

é P L N Profile -~ Relasi Investor ~ Sustainability ~ Media ~ @ Kontak @ ENG ~
Indonesia Power

G CS Pedoman Dewan

GCG Asessment

- Informasi RUPS di pindah laman dari menu Tata Kelola ke Menu Relasi Investor dengan nama menu
Informasi RUPS
- Take out Informasi RUPS di laman Good Corporate Governance

4

Proactive : 2 Mandays
- Design
- System




Tata Kelola - Pedoman Tata Kelola

Good Corporate Governance
Menambah section Sertifikasi

Perusahaan memandang praktik Tata Kelola Perus: GCG <elangsungan usaha, menjaga kepercayaan para pemangku
kepentingan, dan menumbuhkan integritas Perusahaan. Pedoman Tata Kelola Perugahaan disusun sebagai acuan dalam pengelolaan bisnis PT PLN Indonesia Power
berdasarkan prinsip Good Corporate Governance (GCG) yang menjadi kaidah dan pligloman bagi seluruh insan perusahaan dalam menjalankan aktivitas bisnisnya.

logo logo
Nama Nama
Sertifikasi Sertifikasi

Menambah judul Penghargaan
GCG

o)

Proactive : 2 Mandays
- Design
- System




Informasi RUPS

N\ /7
7o

BN l Beranda v Individuv UMKM . Korporasiv Wealth+ E-Banking. Investor v Q 1D

@A Home / Perseroan / Tata Kelola / RUPS

; Proactive : 3 Mandays
. ) - : » ’

‘\f @ § layout icon center - Design

UPsS Pengumuman Pemanggilan Hasil Berita Acara Divide

- System

Pengumuman RUPS

L) pengumuman Perubahan Jadwal RUPS Tahunan Tahun Buku 2024 - 26 Maret 2025 12025
B T T T s
F—— -3
- judul menjadi -> Informasi RUPS
Mohon membuat konten dengan penjelasan berikut:
- lkon dicustom sesuai laman PLN Indonesia Power, termasuk warna Korporat.
- Section pertama paling kiri nama menu -> RUPS
- Section kedua nama menu -> Pemberitahuan dengan layout ditambah keterangan tanggal publish.
Tanggal publish bisa dicustom. Kemudian, sort by tanggal terbaru.
- Section ketiga nama menu -> Risalah dengan layout ditambah keterangan tanggal publish. Tanggal

publish bisa dicustom. Kemudian, sort by tanggal terbaru.




Laporan Tahunan

|- &) @ https: i i i id/laporan-tahunan

Company Profile Business Solution - s
ook ikl i Financial Statement

Financial Statement 2023

Corrective : 1 Mandays
- System

PLN Profile v RelasiInvestor » Sustainability v Media v & Kontak @ ENG ~
Indonesia Power

Annual Report
Annual Keport 2023

Sustainability Report
Sustainability Report 2023

GCS

o, UNDUH FILE

- Keterangpan size file tidak berubah setelah
diubah keterangannya di dashboard admin.

« Statistic Report
Statistic Report 2023

- Take outjudulini, karena sudah ada
keterangan judul file.

LLLLLLLLLL



Laporan-Laporan

% PLN Profile ~

. @ Kontak @ ENG ~
Indonesia Power

Relasi Investor ~  Sustainability ~ Media ~

Laporan Lainnya

Annual Report ! v Annual Report Annual Report

s - -
i 23 - 2022 A\ © 2021
L
3 A e, | o A o M .
A =2 o, :
=3 =
&, UNDUH FILE oL, UNDUH FILE

&, UNDUH FILE

Annual Re;lort ':= & Annual Report Annual Report

GCS .;;’ 5.~ T

\ 4

- Tidak ada kolom untuk pengisian tanda strip
pada dashboard admin di semua laman Reports.

- =>Jadinya ditakeout semua inputan deskripsi,
cukup input title.

- Laporan tahun terakhir tidak perlu muncul di
section Laporan Lainnya.

» Corrective : 1 Mandays
- System

Laporan Lainnya

Sustainability
Report 2023

&, UNDUH FILE

Laporan Lainnya

Statistic Report
2023

o, UNDUH FILE

Laporan Lainnya

Financial Statement 2023

Laporan Keuangan Konsolidasian

L, UNDUH FILE

Sustainability
Report 2022

o, UNDUH FILE

Statistic Report
2022

&, UNDUH FILE

Financial Statement 2022

o, UNDUH FILE

e Vo - Sustainability
\ o ® Report 2021
-] =
ey,
[ T

h?’
<, UNDUH FILE

Lo ™ Statistic Report
2021

o, UNDUH FILE

Financial Statement 2021

o, UNDUH FILE



Laporan-Laporan

% PLN

Indonesia Power

w 2014 E'{E. 2013 ~ Gl 2012

o, UNDUH FILE

Profile ~ Relasi Investor ~ Sustainability ~ Media ~

(i

o, UNDUH FILE &, UNDUH FILE

_ Annual Report Annual Report
2011 2010

| Annual Report
. 2009

o, UNDUH FILE o, UNDUH FILE

<¢ZO
}

- Navigasi ke kanan di laman Annual Reports
tidak berfungsi.

\ g

Corrective : 1 Mandays
- System

L, UNDUH FILE

@ Kontak @ ENG ~

(A} > Financial Statement

Financial Statement

Financial Statement 2023

Laporan Keuangan Konsolidasian

o, UNDUH FILE

Financial Statement 2023

Laporan Keuangan Konsolidasian

m:ial Statement 2022 Financial Statement 2021
o, UNDUHFILE o, UNDUHFILE
oA, UNDUH FILE l

Tidak ada kolom untuk pengisian keterangan
Laporan Keuangan Konsolidasian pada
dashboard admin, sehingga muncultanda
strip. => Jadinya ditakeout semua inputan
deskripsi, cukup input title.



COM

Home

Konsisten Dukung
Bauran Energi

Berpengalaman dan Terpercaya selama lebih dari 26
tahun bersama membangun negeri

i

1. Tidak menampijlkan copywriting -> tidak mandatory, ITD akan menyiapkan tipe
desain yang biga diklik juga jika suatu saat dibutuhkan

2. Bannervideo, durasi berapa lama? -> dapat di-setting durasi setiap banner,
jenis format video MP4 yg diunggah di web , dimensi akan segera diinfokan

» Bisa dikelola melalui CMS admin panel (backend)
=> Menu Banner > File > Edit > Hapus Title dan Description




Home

COMPERHENSIVE BUSINESS SOLUTION

WETNCHEN ML ELET R A ETN(" [H{e)l | Operation and Maintenance (OM)

RNE Provider | Digitalization | | Learning

F4PLN

Indonesia Power
With over 25 years of experience in thermal and renewable power generation, we provide

world-class Maintenance, Repair, and Overhaul solutions, including Retrofit & Recovery,
Turbine Field Services, and comprehensive Overhauls. Our certified professionals and

standardized equipment ensure top-tier service. Guided by our SON principles, we are

C o M committed to delivering cutting-edge solutions to optimize your operations with excellence.
DETAIL LAYANAN

Typo COMPREHENSIVE
¥

Bisa dikelola melalui CMS admin panel (backend)
=> Menu Widget > Landing Page Business > Edit pada Description




COM

ok owbd

Listrik di Seluruh Indonesia

—
35 ALL 6 PLTGU 4 PLTDG apTA L 1pUTP
andakan Santo
Kuala Terengganu
el i ;

Tidak menampilkan keterangan jumlah angka unit, namun hanya angka total
kapasitas PLN IP

Perkecil space antara judul Pengembangan Optimal dan maps

Unit Bisnis Pembangkitan -> UBP , space nama unit hingga ke batas kolom
Lingkaran hijau ada angka diganti menjadi -> sama dengan titik maps biru
Atau alternatif ke-2 , ada 1 section/space di bawah judul berisi angka total

kapasitas. 21,5 GW

Total Kapasitas Pembangkit Dikelola

°
e PLN .
PETA ASET PEMBANGKIT PLN INDO) QWER %PLN Proactive : 2 Mandays
Per 31 Desember 2024, PLN Indonesia Power mengelpla 21 ,5 GW pe bangkit (~448 mesin)* sebagai Aset Owner & Operator serta .
pengelolaan jasa O&M 124 MW (9 mesin), yang terseba{36 Unit Bisnis B€mbangkit & 1 Unit Bisnis Pemeliharaan - D e S I gn
- System




...........

Unit Bisnis...
Kapasitas 740 MW
sl Lihat Lokasi /

nit Bisnis...

apasitas 557
hat Lokasi 7

COM

=

Default setting terlihat nama unit-unitnya -> mohon konfirmasi

Hilangkan keterangan hijau 3

Ketika klik Lihat Lokasi akan zoom Lokasi

Jika klik bagian judul unit dan gambar unit akan pop up keterangan unit:
Nama Unit, Kapasitas Unit, Alamat, Mengelola jenis pembangkit apa saja.
Misalnya dg Ketika klik muncul kotak yg lebih besar berisi profilyg sama dg

yg ada di laman unit pembangkit.
Proactive : 2 Mandays

» - Design

- System

PhoON=




COM

Our Commitment Towards Green Energy

583.143.711 927.036.248

Reduksi CO2 (Kg) Penghasil Energi Hijau (MV)

Proactive : 1 Mandays
- Design

Ada efek pada angka agar tidak statis »

Sertifikasi Kami

o o _ Bisa dikelola melalui CMS admin panel (backend)
1. Judulsertifikasi kami diganti -> » => Menu Widget > Landing Page Certificate > Edit pada
Sertifikasi Nasional dan International Description

2. Yg tampil hanya logo sertifikasi dan bergerak. data Proactive : 2 Mandays
berbeda dengan page Penghargaan dan Sertifikasi. » - Design

Konfirmasi ke vendor. Dibikin sama dg homage bisnis. - System




Home

Sertifikasi Kami

: —>Boem  EBNSP i

Mohon loader sertifikasi kami berbeda dengan laman

COM Penghargaan dan Seritikasi. di home yang tampil seperti
di samping pada Home web Business Solution.

@baru Indonesia POD

23 April

23 April 2025
PLN Indonesia Power UBP Asam Asam Terima Penghargaan dari  Hijauk

23 April 2025
Dewan Komisaris PLN IP Kunjungi PLN IP UBP Priok Pastikan

Memperbaiki judul menjadi -> Berita Terbaru PLN Indonesia

Power

—

National & International Certificate

»

flh
;
i
1|

L3P
=
-oi
L]

Poin ini sama dengan halaman 13

Bisa dikelola melalui CMS admin panel

(backend)
=> Menu Widget > Landing Page News >

Edit pada Title




Profil - Profil Kami

Penghargaan Kami

Sertifikat OHSAS 18001:2007 Sertifikat SNI1SO 14001:2015 The Best Leadership
Occupational Health and... Environmental Management.. Development Human Capital..

COM

Memindahkan section Penghargaan di laman Profil ke
section bawah setelah section Anak Perusahaan

” :LN lndongsia @ Maxpower
ower Services Cogindo Batam

O , 1. Take out fitur anak perusahaan
2. Section dipindahkan ke sini

Proactive : 2 Mandays

‘ - Design

- System

Bersama Kami Contact Us to Get x E

E Membangun PLN Guidance and Help >
Indonesia Power

4



COM

. Yg keluar adalah jumlah kapasitas berdasarkan jenis

Profil — Unit Pembangkit

Unit Pembangkit

PLTGU PLTDG PLTA PLTP @ ©
v

menghasilkan energi panas.

Menambah jenis pembangkit yang lain PLTS, PLTSA, PLTST

pembangkit: PLTGU, PLTDG, PLTA, PLTP, PLTS, PLTSA

Ganti judul -> Total Kapasitas

Mengelola Total Kapasitas Lebih g

Pembangkit Listrik Tenaga Uap

=

=

Pembangkit Listrik Tenaga Uap (PLTU) menggunakan uap panas untuk
menjalankan proses penguapan air dan bahan bakar batu bara serta minyak untuk

Bisa dikelola melalui CMS
admin panel (backend)

=> Menu Unit Pembangkit > Unit
Pembangkit Type > Create New
Unit Pembangkit Type

Proactive : 1 Mandays
- System




COM

Profil — Unit Pembangkit

gIobaI.button.view_a@

(A Uit Bisnis Pembangkitan Priok

Unit Bisnis Pembangkitan Cilegon

sl 07 Kapasitas Terpasang
i 740 MW

"‘ Cilegon [ Energy Prime} Gas

7% Unit Bisnis Pembangkitan Grati

Pasuruan, Jawa Timur 7 Energy Primer: Gas

L Kapasitas Terpasang
1258 MW

Unit Bisnis Pembangkitan Mahakam

o Samarinda, Kalimantan 7 Energy Primer: Gas

Priok, Jakarta Utara 7 Energy Primer: Gas
’ 7 Kapasitas Terpasang
1196 MW

Unit Bisnis Pembangkitan Semarang

3 Semarang, Jawa Tengah 7 Energy Primer: Gas

7 Kapasitas Terpasang
1409 MW

Unit Bisnis Pembangkitan Keramasan

B i
J 7‘:% Palembang, Sumatera {7 Energy Primer: Gas

1. Judul section -> Unit Bisnis Pembangkit PLN Indonesia Power
2. Disectionini keluar informasi 35 UBP dg scroll kebawah. Bukan

berdasarkan jenis pembangkit.

3. Menggantijudul Energy Primer menjadi -> Jenis Mesin Pembangkit

» Proactive : 1 Mandays
- System




COM

—
.

Temukan Unit Kami

Unit Bisnis Pembangkitan

Unit Bisn

\ 4

Kontak

Unit Bisnis Pembangkitan Q

Unit Bisnis Pembangkitan Suralaya

Unit Bisnig.B TORItan Suralaya berlokasi di ujung barat Pulau r iQgi Banten
gelola 7 unit Pusat Listrik Tenaga Uap (PLTU) yang menggunakan batu bara sebas

View Location /

Unit Bisnis Pembangkitan Cilegon

Unit Bisnis Pembangkitan Cilegon berlokasi di Desa Margasari Kecamatan Pulo Ampel,
Kabupaten Serang dengan kapasitas terpasang 1% 740 MW.

View Location

Unit Bisnis Pembangkitan Saguling

Unit Bisnis Pembangkitan Saguling berlokasi di Rajamandala, Bandung Barat, Jawa Barat.
Terdapat 8 sub unit Pusat Listrik Tenaga Air (PLTA) yang dikelola oleh UP Saguling yaitu PLTA
Saguling , PLTA Plengan, PLTA Lamajan, PLTA Cikalong, PLTA Bengkok, PLTA Kracak, PLTA...

View Location

ar utamanya. Dengan total kapasitas terpasang sebesar 3400 MW menjadikan UBBAurala...

Kalbar 1 Operation and Maintenance Services Unit

Dusun Tanjung Gandul, Desa Karimunting, Kecamatan Sungai Raya Kepulauan,
Kabupaten Bengkayang, Propinsi Kalimantan Barat

Q, (+61-21)5267666 &0 (0216336719 Kalba@plnindonesiapower
Lihat Lokasi 2

Jeranjang Operation and Maintenance Services Unit
Dusun Jeranjang Desa Taman Ayu, Kec. Gerung Kab Lombok Barat NTB
QR (+61-21)5267666 Eh (021)6336719

Lihat Lokasi A

Holtekamp Operation and Maintenance Services
Unit
JI. Hanurata KM 9 Kampung Holtekamp Distrik Muara Tami, Kota Jaya Pura PAPUA

% (+61-21) 5267666 EU (021)6336719

Lihat Lokasi A

Nampak sebanyak 34 UBP agar tidak scroll kebawah , akan muncul sesuai pulau.
Keterangan di bawah judul unit seperti di desain saja, Alamat, nomer telfon, fax, dan ditambah

email.

Mohon bantuan utk loader Temukan Unit Kami dan Unit Pembangkit dibedakan.

Proactive : 3 Mandays
- Design
- System




Kontak




Home

Our Commitment Towards Green Energy

983.143.711 627.036.248

Reduksi CO2 (Kg) Penghasil Energi Hijau (MV)
K3L l l
ety «2 369
' 9.543. 432 55 Program Reduksi Emisi
- Ton CO,e
2132,48% ‘

Corrective : 1 Mandays
- System




Sustainability - Environment Management

k P L N Profile ¥ Relasilnvestor ¥ Sustainability ¥ Media ~ ’ @ Kontak @ ENG ~
Indonesia Power

Sustainability Corporate Social Environmen t Occupational Health and Safety (K3) and Gender
Commitment Responsibility (CSR) Management Electrical Safety (K2) Mainstreaming

K3L

WSO Indonesia Safety Culture 3 Unit TOP CSR Awards 2022 Star
Award dan WSO Pakistan Safet.. 5

Penghargaan PROPER 2024 1 piala dengan keterangan jumlah unit peroleh unit emas

$

Bisa dikelola melalui CMS admin panel (backend)

=> Menu Content > Penghargaan dan Sertifikasi > Klik Post > Klik Tambah
Post > Pilih Category di sisi kanan > Pilih Penghargaan > Pada bagian Addon
Field — Type Award, checklist Sustainability Environment




Sustainability - Environment Management

Reduksi Emisi (ton CO2/MWh)

- -

XX

- Ganti icon karena tidak sesuai harusnyaicon
K3L jenis pembangkit, seperti di bawah

Reduksi Emisi (ton CO2/MWh)

Per 31 Desember 2023

section Reduksi Emisi dan tanggal update terakhir data
(size font kecil)

Bisa dikelola melalui CMS admin panel
(backend).

Tapi akan ada update sistem dikarenakan
dari user akan menggunakan file dengan
format sleain .svg: .png

[l

Proactive : 2 Mandays
- Design
- System




Sustainability - Environment Management

Tambahan section untuk konten Carbon Trading

* Section seperti ini dengan konten: icon pembangkit, nama pembangkit, skema carbon credit
(SPE/VCS), keterangan Karbon Kredit Terverifikasi

K3L & ® $

XXX roter XXX potontangia 1000 sear

Ditanam Ditanam Pada Area Rehabilitasi Luas Area Konservasi

Update: 22 Januari 2025

* copywriting: Update 22 Januari 2025 -> diganti Beli di Sini (jika diklik masuk ke link

www.idxcarbon.co.id)

Proactive : 2 Mandays
- Design
- System




HCD

Manajemen Human Capital — Bekerja di PLN Indonesia Power

and strong connections within the energy sector can offer valuable
networking opportunities. You'll have the chance to collaborate with

industry professionals and experts, helping you grow your career.

@ Commitment to Safety: Energy production, especially in power plants,
requires a high level of safety and risk management. PLN Indonesia Power
likely adheres to strict safety standards, making it a safe workplace for
employees.

If vouLl aOoUT energy, sustainable development, and want to work for

a company that contributes significantly to Indonesia's economic development,
PLN Indonesia Power might be a great place to consider working.

Mohon menambahkan 1 section kurang
lebih berbentuk berikut (akan diperbaiki),

Proactive : 1 Mandays
- Design
- System

Dari sisi user perlu mengkonfirmasi apakah section yang
ditambahkan akan menggunakan metode input upload
image atau input description text ?

Apakah ada penambahan sidebar kiri seperti halnya gambar
di samping yang dijadikan contoh ?




Manajemen Human Capital — Bekerja di PLN Indonesia Power

Joinus

Together, Advancing Indonesia’s Growth

- Take out Join Us di section paling bawah

[l

Corrective : 1 Mandays
- System

HCD




Sustainability - Gender Mainstreaming

% ‘le. N Profile + Relasilnvestor ~ Sustainability ~ Media ~ | & Kontak @ ENG =
naon:

[ ional Health and Safety (K3) and Gender

Sustainability Corporate Social

Ci ibility (CSR) Management Electrical Safety (K2)) Mainstreaming

Keselamatan dan Kesehatan Kerja (K3)

dan nyaman sehingga aspek keselamatan dan Keset
PLN Indonesia Power dapat terjaga.

Salah satu upaya Perusahaan untuk mewujudkan Zero Accident yaitu dengan cara memperkuat
safety culture di seluruh lingkungan kerja PLN Indonesia Power merupakan suatu keharusan
yang menjadi nilai inti Perusahaan melalui serangkaian proses yang dikelola secara professional

dan berkelanjutan

Dengan keteriibatan dan komitmen penerapan safety culture oleh seluruh pemangku kepentingan
seperti Manajemen, Pegawai, Tamu, Mitra kerja dan Masyarakat sekitar serta adanya penerapan
standar keamanan tertinggi oleh Perusahaan, PLN Indonesia Power konsisten menjaga kinerja

K3 dan berhasil Maturity Level Pengelolaan K3 untuk mencapai Z

Accident.

Mohon bantuan menambahkan Gender Mainstreaming menggunakan desain yang sama dengan sub

Sustainability Corporate Social O i Health and Safety (K3) and
Commitment Responsibility (CSR) Management Electrical Safety (K2))

achieving the Sustainable Development Goals (SDGs).
PRINCIPLES OF SOCIAL AND ENVIRONMENTAL RESPONSIBILITY PROGRAM (TJSL)

Implementation of the TJSL program by applying the following principles:

P | N @ Integrated, namely based on risk analysis and business processes that are related to
stakeholders;
[ ]
e I @ Directed, namely having a clear direction to achieve the company's goals;
@ Measurable impact, namely having a contribution and providing benefits that result in

. changes or added value for stakeholders and the company; and
By PLN Indonesia Power
@ Accountability, which can be accounted for to avoid potential misuse and deviation

COMMUNITY DEVELOPMENT- PLN INDONESIA POWER CARES

The implementation of the CID proaram of PLN Indonesia Power on the pillars of Social,
Program CSR Unggulan

ELANG BODAS (Pertanian Optimal yang Terintegrasi dengan
Biodigester Desa Pulosari)

Merupakan program pemberdayaan masyarakat binaan PLTP Gunung Salak untuk
menginlegramkan keglalan pengelolaan kotoran hewan ternak dengan biodigester
dan optimalisasi sektor pertanian serta pengembangan dapur umum posyandu..

MENYAMA BRAYA (Menyusur Mangrove Berdayakan
Masyarakat dan Alam Raya)

Menyama Braya bersumber dari filosofi ajaran karma marga masyarakat Bali yang
bermakna per , bekerja ber. , dan oyong dalam
mewujudkan tujuan bersama. Filosofi Menyama Braya menjadi semangat dala..

laman CSR. Ada dua jenis template section berbeda seperti di atas.

Proactive : 2 Mandays
- Design
- System

Gender
Mainstreaming



Pedoman Tata Kelola

Pedoman Dewan 4 Take out konten Sistem Manajemen Kepatuhan di

€6 Asessment . laman Pedoman Tata Kelola = akan menjadi sub
laman sediri.

Informasi RUPS \

Cﬁw Manajemen Kepatuhan >

Profile ~ Relasilnvestor ~ Sustainability ~ Media v | & Kontak & ENG ~

RSC

Profile

Mohon menambahkan satu laman lagi berjudul ->>
Sistem Manajemen Kepatuhan

Manajemen Human Capital » Manajemen Anti Penyuapan

Whistle Blowing System

Pengendalian Cratifikasi
LHKPN

Tata Kelola Manajemen Risiko

Proactive : 2 Mandays
- Design
- System




Section 1

Section 2

RSC

Section 3

Mohon bantuan layout laman Sistem Manajemen
Kepatuhan seperti contoh di atas

Sistem Manajemen Penyuapan

Sistem Manajemen Kepatuhan

PLN Indonesia Power melawan terjadinya tindakan dan praktik yang mengarah pada tindak pidana suap, fraud,
benturan kepentingan, dan gratifikasi. Sebagai upaya menghindari terjadinya praktik korupsi di lingkungan
Perusahaan, PLN Indonesia Power telah memiliki SNI ISO 37001:2016 Sistemn Manajemen Anti Penyuapan
dengan memberikan panduan untuk membantu organisasi baik sektor publik, swasta dan nirlaba dalam
membangun, mengimplementasikan, dan terus meningkatkan program kepatuhan atau SMAP dengan tujuan
untuk mengidentifikasi, mencegah, dan mendeteksi penyuapan.

Insan PLN Indonesia Power bersama Stakeholder terapkan pelaksanaan SNI ISO 37001 : 2016 Sistem
Manajemen Anti Penyuapan dengan prinsip 4 NO's.

vV KAN

LSSMK-001-IDN

CERTIFICATE 10 - GHI 230005

Dalam penerapan Manajemen Kepatuhan

@ Setiap Insan PT PLN Indonesia Power wajib menerapkan Manajemen Kepatuhan dalam pelaksanaan seluruh aktivitas proses
bisnis Perusahaan, sesuai dengan fungsi tugas dan tanggung jawabnya;

@ Penerapan Manajemen Kepatuhan melibatkan seluruh Insan PT PLN Indonesia Power dan Pemangku Kepentingan lainnya
secara konsisten dan berkelanjutan dengan berpedoman pada peraturan dan ketentuan eksternal maupun internal yang berlaku
di PT PLN Indonesia Power;

Penerapan Manajemen Kepatuhan meliputi:
Kepatuhan terhadap peraturan perundang-undangan;

Kepatuhan terhadap peraturan internal PT PLN Indonesia Power;

Kepatuhan terhadap kode etik; dan

©
&
@ Kepatuhan terhadap komitmen;
©

Kepatuhan terhadap nilai-nilai perusahaan.

©

Penerapan Manajemen Kepatuhan wajib dimonitor dalam rangka sebagai:
@ Salah satu indikator dalam pelaksanaan Tata Ketola Perusahaan yang baik (Good Corporate Governance);

@ Upaya untuk memitigasi risiko kepatuhan, risiko hukum dan risiko reputasi serta mencegah timbulnya kerugian PT PLN
Indonesia Power.

Poin ini berkaitan dengan halaman 27




Whistle Blowing System

Anonymous

Name Phone Email

Reporte i
Pelanggaran Kode Etik Pelanggaran Benturan Kepentingan Pelanggaran Hukum
Reported Nal

[ ] Reported Position

Occurence Time

07/03/2025 Occurence Location

Report Message

ERROR fo
Invalid do

Mohon perubahan pada Reported Actions:

1. Fraud
2. Pelanggaran »

3. Tidak termasuk fraud/pelanggaran




Tata Kelola Manajemen Risiko

Risk Maturity Index PT PLN Indonesia Power

RSC

2019 2020 2021 2022 2023

Mengganti judul menjadi -> Target dan Realisasi RMI Tahun 2024
l Grafik juga berubah karena ada 2 fitur.

Proactive : 2 Mandays
- Design
- System

Dari sisi user perlu mengkonfirmasi apakah metode input menggunakan field/form
atau upload image ?




COM

Penghargaan dan Sertifikasi

Penghargaan dan Sertifikasi

Sertifikat BNPT
Pesanggaran

Acara Penghargaan

Asesmen Penerapan Standar Minimum
Pengamanan Berdasarkan Peraturan BNPT
Nomor 3 Tahun 2020

Tahun Perolehan
2024

Badan Pemberi Penghargaan
Badan Nasional Penanggulangan
Terorisme (BNPT)

Mohon tambah fitur inputan:

{

Proactive : 1 Mandays
- System

Unit Penerima Penghargaan
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Sertifikat BNPT Pelabuhan Ratu Sertifikat BNPT Berau Sertifikat BNPT Banten 3 Lontar
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csR GAEEN ENERGY

Dukung Pencapaian Generasi Emas, PLN  PLN Indonesia Power UBP Bali Perkuat PLN Indonesia Power Bukukan

Indonesia Power Tangani Stunting di Daya Dukung Energi Bersih untuk Pendapatan dan Laba Tertinggi, Lampaui
Nusa Penida Pariwisata dan Kesejahteraan... Tahun 2023 dan Target RKAP 2024

25 June 2025 25 June 2025 20 June 2025

Mohon Batasi page Page hingga 5

Corrective : 1 Mandays
System
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